EDITING A PAGE

Logging In

Note: If you are off-campus, you will first need to vpn in, before following the instructions below.

Ektron works well with Firefox and Chrome, and usually works “okay” with Internet Explorer.

Go to http://cmslogin.sdsmt.edu. Log-in using your SD Mines network passwords. These credentials are processed through Active Directory, used by the entire SDBOR system, so it takes a little while to load. Once you have logged in, click on Workarea.

The desktop of the workarea will look different for different users. Your desktop might be empty. There are two sections of the workarea that SD Mines publishers will use:
1) CONTENT: where you will find assets like webpages and documents.
2) LIBRARY: where you will find or place images.

Click on the Content Tab.

Navigate through the Content Folder Structure

In Ektron terminology, webpages are “HTML Content Items.” They live in folders within the Content folder structure. The folder structure more-or-less mirrors the structure of the SD Mines website. You may see what look to be empty folders – these folders most likely contain library items (images and stored links), but their content doesn’t show up unless you are working in the Library tab.

Locate the folder you have publishing rights for. For example, someone in an academic department would click on the “Content” folder, that folder would expand, then they’d click on the Academics folder, then the Departments folder, then the folder for their department.

Within the folder structure, it is usually the case that the introductory page to specific subject matter lives in the folder above whichever folder contains the main body of that information. For example -- the "home page" of the Registrar’s Office (a content item named "Registrar and Course Enrollment") lives in the Academics folder. All other Registrar information lives in the Registrar folder and its subfolders. You should have access to that introductory page as well.

Academic Departments are structured differently. For an academic department, the home page or introductory page is in the department folder and its name is the name of the department.

Once you have clicked on a folder, its list of contents appears (see image above). That list provides information about the content items, including last editor and last edited date. One important piece of information it shows is the Status of each content item.

Remember to check https://www.sdsmt.edu/EditWebsite for training documentation and updates.
Below is a list of what the status indicators mean:

**Status Indicators:**

- **A – Approved:** content is published to the website (or will be after the next sync).
- **O – Checked Out:** content is checked out while being edited and can only be accessed by the individual who has it checked out, or a website administrator.
- **I – Checked In:** Content has been edited but not published, anyone with publishing rights to it can access it.
- **P – Pending Go Live Date:** Content is pending—it has been scheduled to appear on a future date and that date has not been reached yet.
- **S – Submitted for Approval:** Content has been submitted for approval and will go live when approved.

---

**View, then Edit, an Existing Content Item**

1) **Click on the name of the content item.** You’ll first see that content in “view” mode. This allows you a preview of content before you click the Edit button to begin making changes. The View and Edit toolbars you see vary depending on the rights/permissions of the individual user. The following icons on the View toolbar provide the capabilities described below. You may see some or all of these icons.

**Back** -- go back to the previous screen

**Edit** -- Open a content item or smart form for editing

**History** -- See the history of your editing changes. *From here you can restore a previous version. This is useful if you have made a serious mistake and published. If you do restore, only the main content of the page is restored. You will need to edit the page and re-add the banner image, CTAs and Related Links (using the Metadata tab) then publish it. Or notify UR for assistance.*

**Delete** -- Delete a content item or folder (if you have rights to delete; most publishers do not as deleting requires companion work on the website navigation menus.)

**Check Links** -- A useful tool that allows you to see if other pages on the website link to this page. If you have delete capability, check this first to see if links exist to your content that will become broken links if you delete it. If you cannot change those links (the linking page is a page you don’t have rights to), then contact the UR web team.

**Add Task** -- communicate with someone about actions needing to be taken.

**View Content Reports** -- not used at present.

**Sync** – publish content from the staging server to the production server. Department publishers will not have sync capability. The system syncs once per day at 5 pm. Contact UR if you need something to be synced earlier.

**Help** - Access Ektron user documentation.

**Click on the Edit button to edit a Content Item**
Editing – the Aloha Editor

The content item will open up in the editing screen.

The Aloha Editor has a small toolbar that appears at the top of your page. It offers a variety of tools (see right column) under the Format, Insert and Review tabs.

Publishers who used the earlier Ektron editor, the CMS400, will be pleased to know that Aloha works much better with text copied from MS Word documents or Outlook emails. That text can now be directly pasted into your page, and Aloha will automatically remove conflicting formatting and the extraneous hidden “Word html code” that used to cause display problems. Hooray!

Images cannot be pasted in like text. You’ll have to upload them to the Library and then insert them into a page. Working with images is covered later in this document.

Standard formatting tools are available in the editor. Hover your mouse over the icons for tool tips, if you are unsure what a particular tool is for.

Per our style guide, please use the default font (PT Sans) – and no others. Headings should be Heading2 size with a class of “textGoldOnLight” applied. Sub-headings are Heading 3.

(see image at right)

Inspector Tool

The Inspector tool, which is activated from the Review toolbar, allows you to format elements of your page. First you click on an element to select it (for example, a header, a paragraph, a table, a bulleted or numbered list, or a table), then use the Inspector to add additional attributes, formatting or functionality.

The image right shows an example of H2 header text made gold by adding the class “textGoldOnLight.”

Tips for:

Adding the gold color to the title (header) of your page. Type the title you want to use. From the formatting bar apply Heading 2. Click on the heading and open the inspector, scroll down (if you need to) to see the box for Css Class – there type textGoldOnLight – with no punctuation or spaces; classes are case sensitive: lowercase + capitals must be used as shown. (see image above). Only the H2 header at the top of your page should be gold.

Adding an internal link (a link to an SD Mines webpage): select the text you want to link, then from the Insert tab, select the library icon (first icon in the row: the book icon) and navigate within Ektron folder structure to the Quicklink for the webpage or document you want to link to.

Email link: Use the Format tab and enter the email address using “mailto:” in front of it. Example: mailto:John.Smith@sdsmt.edu.
Add an external link/make it open in a new window: Type or select the text to link, click on the Link icon under the Format tab, add the URL making sure it begins with http:// or https://, example: http://www.gorockers.com. Then to open this page in a new window, click on the linked text on the page, use the Inspector (see image right), make sure you are working on the A tag, and click the “Open in a new tab/window” box. Links to external websites should always open in a new tab or window.

Adding numbered or bulleted text: Type your items, hitting return between them (don’t single space them by using Shift + Return). Highlight the group when you are done and use the icon on the Format tab to apply bullets or numbers.

Add a table: Use the Insert Tab to draw the number of cells and rows you need. Input information into your table. When done, apply a class of table and it will properly space your information and underline each row. It will also make your table responsive. For more about tables, see Addendum A on Working With Tables at the end of this document.

Other classes you can apply:
center – to center text
marginTop0 – to remove space above a paragraph or other element
marginBottom0 – to remove space below a paragraph or other element
textGreen – to differentiate text (green is our standard for highlighted information)
floatLeft or floatRight – to align an image left or right; text will wrap to the other side
imgRightPadding or imgLeftPadding – to add space around your right or left aligned image
img-responsive – to make a large image resize in various screens and devices
Note: add right padding to floated left images, and left padding to floated right images.
Multiple classes can be added to the same element with a single space between them: example: floatLeft imgRightPadding marginTop0

Working with content in the Library:
When you work in the Library or navigate to it for items like images, Quick Links or Hyperlinks, be sure you change the dropdown list to show the type of item you are seeking: Images, Quicklinks, Hyperlinks, Files, etc.

Edit in Context
Make sure you are logged in to Ektron, but instead of editing the content item in the Ektron editing interface, you can edit the webpage right in your browser. You will make the change on the staging site (not on the live website), so you need to have the staging webpage open.

For example, if you need to edit https://www.sdsmt.edu/Campus-Services/University-Relations/ change the URL to https://ektron-stage.sdsmt.edu/Campus-Services/University-Relations/ in your browser, then editing options will appear. (Note: you can only change pages that you have the rights to edit).

At the top of the page, a new toolbar will appear. Click on the button “Switch to Edit.” A yellow border will appear on editable areas of the page. When you click into that area, you’ll see a menu icon in the top right corner of the area. Click on the icon to expand the menu, and then click Edit in Context.

Remember to check https://www.sdsmt.edu/EditWebsite for training documentation and updates.
The yellow border will turn blue, and you’ll get the editing toolbar. Make your changes, using the Aloha Editing tools as needed. You’ll notice the Toolbar now has a fourth tab labeled File. There you can save your changes or cancel them. If you save them, your work will publish out to the live site at the next sync time (more information on syncing below).

Creating a New HTML Content Item (or webpage)

If you need to add rather than edit a page, then navigate to the folder where you want to add. You must have rights to add content within that folder. If you have those rights, you’ll see that you have a “New” button at the folder level.

Click on the New button and from the dropdown list that appears, click HTML Content.

Provide your new HTML content item with a “title.” The word “title” is a little misleading here, because you are not providing the headline for the content of your page, you are naming the content item. This name shows up in the Ektron folder, in the breadcrumbs on the live site, and in the left navigation on the live site, once it’s added to the navigation menus. You want to pick as short a name as possible (e.g. “Military Students”). You will still have to provide a title within the actual content you put into your webpage. That title can be longer, e.g. “Military Students at the South Dakota School of Mines & Technology.”

Add content to your page following the “Editing a Page” instructions described earlier.

Please be sure to follow the university website style guide (available from www.sdsmt.edu/EditWebsite) in adding content to the website.

Adding your page to navigation menus: When you have created your new webpage and published it, it will need to be added to navigation. Most publishers will need to notify the UR web team, as the navigation system for most of the website is controlled by UR. Academic department publishers can add the page using your Left Navigation smart form. If you need training on this, contact the UR web team.

ADDING AN IMAGE TO A PAGE

Adding an Image
Steps to adding an image:
1. Properly prepare (size and compress image) for display.
2. Upload image to the appropriate folder in the Ektron library.
3. Add it to your html content item (webpage). See page 6 “Tips” for instructions on left or right-aligning images.

Prepare images:
Images need to be added as .gif, .jpg or .png files to the Ektron Library and should be created at the same size they will display at.* Often camera images or images used for print pieces are large files – too large for efficient web display. When that same image is properly resized and compressed (specifically prepared for web use) it will be much smaller – meaning a faster download for users seeing it on your webpage. Generally, the .gif format is used for line art (think clip art) and .jpg for photographic images. The .png

Remember to check https://www.sdsmt.edu/EditWebsite for training documentation and updates.
format is often useful for images with transparent backgrounds. **No other image formats should be used.** The file size of your image will vary but, generally speaking, images should be **less than 100kb** in size even if they are quite large, like a banner image.

*Because the site is responsive, images 378px or wider should be given a class of **img-responsive** so they will automatically resize as needed for larger or smaller devices. Add this class with the Inspector.*

**Add images while editing a page:** You can add images during the process of editing or creating your webpages. Use the **Insert tab** on the editor toolbar and insert a library item (book icon).  **Click the folder you want the image to reside in** (your main folder or the `_Images` folder below it) in the list of folders. Then click the Add Library button, browse to the image on your computer that you want to upload and give it a title.

When you click the Add Library button again, it will add the image both to your page and to your image library.

**Add images to the Library:** You can also add images for use in your pages by going to the Library tab, finding your folder, or the `_Images` folder if you have one, and clicking the “Add” button, uploading the image and giving it a name. Be sure “images” is selected in the dropdown box to the right of the “Add” button. (If you see the “New” and “View” buttons instead, you are in the Content Tab and not the Library Tab.) Once your image is saved in the library, you can go back to the content item, in the Content tab, and add the image to the page.

**To add a hyperlink to an image:** click on the image, open the Inspector, click the “Add hyperlink to Image” button, add the URL the image should link to (or navigate in Ektron to the Quicklink you need). Click the box to open the page in a new tab/window, if needed.

**To delete an image from your webpage:** click on the image, open the Inspector, click the “Delete Image” button.

Use images sparingly. If you need to use multiple images, plan your image displays so that images used are consistent in size and position, and make sure images are good quality. Poor image displays make a website look unprofessional. If you need help with images, please contact University Relations and we will be happy to assist.

---

**Adding a Document to the DMS (Document Management System) and linking to it**

**Add a Document:**
In the **Content** tab, (not Library), find the Docs folder most closely associated with the content you are working on. Click on that folder, then in the right pane of the screen, mouseover the NEW button to get the dropdown list. From that list, click on DMS Document. A new screen will open and you need to do two things there: 1) Click on the browse button to find the document on your computer that you want to upload to Ektron. 2) Name the content item. Once you have done both steps, click on Publish. Your document is now uploaded to the Docs folder.

**To link in a webpage to a document that’s in the DMS:**
When a DMS document is added, Ektron creates a Quicklink to that document, just like it creates a Quicklink to a webpage when one is created. Therefore, the linking process is the same. Use the **Insert tab** on the editor, click on the Library icon (book icon), navigate to your Docs folder and choose the Quicklink for that document. All documents should open in a new window. To make that happen, once you have created the link, use the Inspector to check the “Open link in new tab/window” box.

---

Remember to check [https://www.sdsmt.edu/EditWebsite](https://www.sdsmt.edu/EditWebsite) for training documentation and updates.
Save or Publish? And all about “syncing”

The SD Mines website content exists in two environments.
1. the staging environment – where UR web designers and department publishers work to add or change the website, and
2. the production (or public) environment that visitors to our website see.

Syncing: Once every day (currently at 5pm), the staging server syncs to the production server – so anything that has been created or edited, and then published, shows up on the public SD Mines website.

As you work in your content areas, you do need to be aware of this. If you don’t want your work to show up on the live site, then save rather than publish your work. Save your work by using the Save icon (the disk icon at the top of the page) rather than clicking the Publish button. Saved work can be previewed by clicking the preview button. When you are satisfied with your edits, click the Publish button. At the next sync, your published work will appear on the website.

If you save your work, then leave the document without publishing you’ll see a dialog box that asks you if you want to leave the page or remain on the page. If you have saved, you can leave the page and your work will be saved. If you have published, you will not see that dialog box.

If you’ve begun to edit but made mistakes and don’t want to save any of your work, then leaving the page without saving lets you “escape” out of the page, but doing that will leave the content item checked out. That will prevent any other publisher from being able to edit it. So click the “Undo Checkout” icon (to the immediate right of the Publish button), which will check the item back in but not save any changes. A dialog box will let you confirm that you want to leave the page without saving your changes.

Scheduling: If you want to create a page now for future display, then you can Schedule it to appear at a future time and date. This will keep it from appearing on the website until you are ready for it to go live. More on scheduling below.

The other Editor Tabs

In showing examples of using the Editor to add content to your page, in this document, we have always shown the Content tab displayed. There are other tabs as well: Summary, Metadata, Aliases, Schedule, Comment, Templates – you may see some or all of these. The two you may need to use are Metadata and Schedule.

Metadata

The Metadata tab allows you to add components to your HTML content item – including keywords, description, content banner, CTAs (Call-To-Action boxes), site links & related links.

Keywords help with search results – both internal and external searches. If you wish, you can add a few keywords to your page. Think of these as the word or short phrase a user might type in the Search utility to find the kind of content you are offering. Type each word or phrase into the “Text” box, then hit return and you can type in the next.

Description: You may add a short description for your page. If you add this, it’s what search engines will display in the results set when your page is found. If you do not, the search engine will instead use the first few lines of the content of your page.

Content Banner: This is the main image at the top of the page and often is consistent throughout a department or section. To add this, click on Edit. A pop-up box will appear and on the left side you’ll see the display of folders that you’ve seen while working with Ektron content. This display is a little different, however, because it shows Library assets rather than Content assets. Although it

Remember to check https://www.sdsmt.edu/EditWebsite for training documentation and updates.
looks similar, you’re now in a different part of the Ektron system. If you navigate to the top level folder where your content resides, you should see banner images applicable to your content. (A new banner will have to be uploaded to the library before it can be added to your page. Choose the banner image you want (the row above it will turn bright yellow). Double click insert, and the name of the banner will appear in the “Reorder and Finalize Selections” box, at the bottom of the screen. Click Save to add the banner to your Metadata screen. When you save or publish your page, you will have now added the content banner to your HTML content item.

**Left Rail and Right Rail CTA** options are added in a similar fashion. You click on Edit, navigate to the sub-folder (named #CTA) and choose an already-created CTA to add it to your page. Double click to add it, then click Save to bring it into your Metadata display. When you save or publish your content item, the CTA will be added.

**Creating a CTA** (See addendum at end of document: Creating a CTA)

---

**Scheduling Your Content Item**

You can schedule content to appear or to expire, or both. If you schedule your content item to appear sometime in the future, then you can Publish it without it going live on the website. This is a good way to make sure you have time to finish the editing you need to do. (See Schedule screen image, next page).

To schedule your information to appear at a later date, click the first calendar icon (with the plus sign) following “Start Date.” A pop-up calendar will appear, and you can select the date and time you want. (If at some point you need to remove that date, you click the calendar icon with the minus sign.)

You can also schedule content to expire – which is handy in some cases. You schedule content to expire by choosing an End Date for it. After that, you can select “Archive and remove from site” which means your file is deleted once its purpose is served, or “Archive and remain on site” which is useful if you’d like to reuse that content in the future.

If you make changes to Metadata or Scheduling be sure to Publish or Save your page so changes are retained.

---

When you have finished editing your content and have published it, you can log out of the Ektron system.

---

**When should I edit, when should I ask UR to edit for me?**

We provide access to publishing on the website so departments can keep their information correct and current. The CMS gives you the tools for that. It is a “content management” tool.

**University Relations can assist you with:**

- Create folders for you
- Create a new website section with multiple pages
- Change or add navigation
- Use a different template
- Have forms built for you
- Build out pages that require a lot of formatting – i.e. responsive column sets, accordions, tab sets, complex lists or tables.
- Assistance with images
- Remove (delete) existing content items

Please submit a job request through University Relations: [https://interact.sdsmt.edu/ur/job-request.htm](https://interact.sdsmt.edu/ur/job-request.htm)

Remember to check [https://www.sdsmt.edu/EditWebsite](https://www.sdsmt.edu/EditWebsite) for training documentation and updates.
Addendum A: Working with Tables

Working with tables in the Aloha Editor

Creating a table
Use the Insert Tab of the editor to draw the number of cells and rows you need. Input information into your table. When done, use the Inspector to apply a class of `table` and it will properly space your information and underline each row. It will also make your table responsive, so it will change dimensions depending on the user’s screen size.

Use classes of `table table-bordered` if you want to outline the table cells instead of underline the rows.

Note that when you are working in a table, the Aloha editor will display an additional Table tab with tools. If you click beside the table, that tab will offer Table Row tools, if you click above it will offer Table Column tools. These tools let you add or remove rows and columns or perform other table functions.

Merging Table Cells
In order to merge cells together, first select multiple cells by selecting a row, column, or using shift select. Then click the merge cells button in the table menu, this will put all the information into a single large cell.

Splitting Cells
Select the cell you wish to split and select the split cell button. This is basically an “undo” for when you have previously merged cells together.

Add and Delete Rows and Columns
To add or delete entire rows, select the row and the editor will bring up several new options. These include adding rows, deleting rows, and turning a row into a table header. The same options can be used for columns.

Adding a Table Caption
You can add a caption to the table by clicking the table caption button in the table menu. The captions will be inserted at the top of the table.
Addendum B: CTAs
Create a CTA

Note: this information describes the CTA process for the standard 3 column template.

In the three-column template, all CTAs (left and right) will appear on desktop view. Only the first and second right rail CTAs will appear in mobile view.

Go to the _CTA folder within the folder you have publishing rights for. Click on New and a menu appears. From that menu mouse over “Smart Form” and click on Rail CTA when that option appears.

A smart form for creating your CTA will open.

Provide a Title: (Name for your CTA).

Heading: A short heading that displays.

Styling: Choose Boxed or Transparent. Boxed has a light gray background. Transparent has no background (i.e. appears against white on the webpage).

Image: Images are used in one of two ways. You may use a small header image for your CTA that’s then followed by text. Make it a .gif or .jpg file that’s 220 pixels wide and about 80 pixels high. This image does not need to be linked. Alternatively, you may want a graphic to be the entire CTA. Make your graphic about 220 pixels wide (height whatever is needed). You’ll want to have chosen a transparent background under styling for this. Link the image to whatever internal or external page you want to send your audience to.

Description: this is the written text of your CTA. When you click into the Description text area you will get a pop-up editor with the Aloha editing tools. Be sure to save your text when you are done.

Link: A CTA is often teaser information that takes people to other content -- a webpage, a document, a video. Click the link icon to get the Link Manager dialog box – and type in your link text (usually something like: Read More or Register Online or View Video) and add a URL for an internal or external link. You can navigate to internal content (access Quick Links) by clicking the small gray box with the ellipses next to the URL input box.

Scheduling: If your CTA relates to date-specific content, you can make your life easier by scheduling it to appear, to go away, or both. Use the Scheduling tab of the CTA smart form for this.

Add the CTA to a Webpage:
Now you’ve created a CTA but you still need to add it to the appropriate webpage. Go to that webpage and click to edit it. From the Metadata tab, choose whether you want the CTA to appear on the left rail (up to two can be located here) or the right rail (up to three can be added here). Click the Edit button to add the CTA and navigate to the folder and the CTA content item you created to add it. Then Publish your page. The CTA will show up on the live site after the next website sync.

CTAs in a Two Column Template:
The process for adding a CTA in a two column template is similar, but CTAs can only appear on the right rail in a two-column template. You will also need to make your images larger, if you are using them. Make your CTA image for the two column template at least 300 pixels in width, and give them the img-responsive class.

Remember to check https://www.sdsmt.edu/EditWebsite for training documentation and updates.